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PROMULGATION INFORMATION (U)

(U) This manual is issued for the information and guidance of EOD personnel. It has
been prepared by the Department of the Navy in carrying out its responsibilities per
Joint Service Regulation AR 75-14/OPNAVINST 8027.1/AFR 136-8/MCO 8027.1

(U) Distribution of this document shall normally be limited to organizations assigned
graduates of the U.S. Naval School, Explosive Ordnance Disposal. Foreign release of
this document, or any portion thereof, shall require authorization from the Navy
International Programs Office (IPO-11A), Arlington, VA 22202-1111, with an information
copy of the request to Commanding Officer, Naval Explosive Ordnance Technology
Division (AC-9), 2008 Stump Neck Road, Indian Head, MD 20640-5070. Requests by
civil authorities or individuals for release of this document should be forwarded to
Commanding Officer, Naval Explosive Ordnance Disposal Technology Division (Code
60), 2008 Stump Neck Road, Indian Head, MD 20640-5070.

(U) Errors in the EODB or recommendations for its improvement by Navy units shall be
submitted in accordance with NAVEODFLTLAU Publication Note 1-99.

(U) Errors in this EODB or recommendations for its improvement by Marine units should
be submitted to the Officer-In-Charge, Marine Corps Detachment, 2008 Stump Neck
Road, Indian Head, MD 20640-5098, in accordance with MCO 3571.2.

(U) Reports of errors, omissions, and recommendations by Army units for improving this
TM by the individual user are encouraged. Reports should be submitted on DA Form
2028, Recommended Changes to Publications, and forwarded directly to Commander,
U.S. Army Technical Detachment, 2008 Stump Neck Road, Indian Head, MD 20640-
5096.

(U) Recommended changes, additions, or deletions by Air Force units to this T.O. shall
be submitted in accordance with T.O. 00-5-1 to Commander, Detachment 63, 2008
Stump Neck Road, Indian Head, MD 20640-5099.

(U) Published under authority of the Secretaries of the Army, Navy, and Air Force.
Prepared by the Naval Explosive Ordnance Disposal Technology Division, 2008 Stump
Neck Road, Indian Head, MD 20640-5070.
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Chapter 1 - Before You Begin

1.0 Introduction
The MK 32 MOD 2 Advanced Radiographic System, (hereafter referred to as ARS) is a
fully digital X-ray imaging system designed to rapidly acquire radioscopic images in
the field and provide image enhancement tools to facilitate image evaluation.
The system consists of a controller, an imager, and interconnecting cables. Though
image acquisition is fast and uncomplicated, image quality is excellent. Image
manipulation capabilities range from simple to sophisticated and accommodate a
variety of applications. Images are stored on disk in an industry-standard format
that can be readily manipulated and annotated by third party software.

1.1 Safety Information
OPERATING PRECAUTIONS
The X-ray generator used with the ARS produces radiation that can be harmful to
personnel. It is the responsibility of the user to ensure that the ARS is properly
used by trained personnel who follow recommended operating procedures and
applicable regulations. The following safety precautions are recommended by the X-ray
generator supplier and SAIC: *Operating personnel should review and follow applicable
regulations (see Appendix C)*Personnel in the vicinity of the system may be required to
wear an approved radiation monitoring device when the system is being operated (see
Appendix C)*Personnel should stand at a safe distance from the X-ray generator, and
remain outside the direct beam during image acquisition. However, if personnel cannot
be kept outside of the beam angle, they should at least remain 5 meters away from the
X-ray generator (see Figure 1.1).*Although the X-ray beam angle is only 40 degrees, as
a safety precaution all personnel should stand at least 1.5 meters away from the X-ray
generator outside the beam angle. The radiation dose measured outside the direct X-
ray generator beam is negligible (see Figure 1.1).*The Control Unit's interlock key
should be turned to the "OFF" position when not acquiring. The X-ray generator cannot
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fire when the Control Unit's key is in the "OFF" position. *The X-ray generator's power
key should be turned to the "OFF" position when not acquiring images. The X-ray
generator cannot fire when the key is in the "OFF" position. The system operator should
remove the Control Unit and X-ray generator keys when not operating the system, to
ensure that the system is not accidentally or improperly operated.

FCC COMPLIANCE
This equipment has been tested and found in compliance with the limits for a Class
"A" digital device, pursuant to part 15 of the FCC rules. These limits are designed
to provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates and can radiate
frequency energy and, if not installed and used in accordance with the instruction
manual, may cause interference to radio communications. Operation of this equipment
in a residential area may cause interference, which is the responsibility of the user
to correct. Changes or modifications not expressly approved by the party responsible
for compliance could void the user's authority to operate the equipment.

Note: This product was FCC verified under test conditions that included the use of
shielded and/or filtered I/O cables and connectors between system components. To
comply with FCC regulations, the user must use shielded cables and connectors and
install them properly.

Chapter 2 - Setup and Operation

Setup of the ARS Figure 2.1 is a simple task that can be accomplished by a single
individual in less than five minutes. The compact size of the versatile ARS allows it
to be used as a portable system (with the system set up around the target object), or
as a stationary system (with items placed in front of the imager). Once the system
has been assembled, images can be acquired and viewed immediately. Cabling is
provided with the standard system that allows for the Control Unit to be located as
far as 100-meters away from the imaging area.

2.1 COMPONENT OVERVIEW
CONTROL UNIT
The Control Unit Figure 2.2, Figure 2.3 and Figure 2.4 is a fully integrated system
comprised of a Pentium processor, flat panel display with a power-save feature,
internal hard drive, 1.4 Mbyte floppy disk drive, and modem packaged in a lightweight
carrying case.

X-RAY GENERATOR AND IMAGER
When acquiring an image, the Imager and X-ray generator should be positioned as
shown in Figure 2.5 or Figure 2.6 below. The target object should be positioned so that
it is as close as possible to the Imager's conversion screen (face), which is denoted by
the white rectangular outline on the flat side of the Imager. The X-ray generator
should be positioned approximately 60 cm from the Imager with its beam centered on
and perpendicular to the Imager face.
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CAUTION: The knobs on the imager MUST BE loosened prior to moving the handle. If
the knobs are not loosened prior to adjusting or moving the handle, the imager may be
damaged. This would require return of the unit for repair. This configuration may be
appropriate when evaluating objects on the ground that cannot or should not be moved.
The Imager is oriented so that its face is located as close to the ground as possible. The
Imager handle is used to support the Imager so that its face is nearly vertical. The X-ray
generator is set on the ground (or slightly elevated) so that the X-ray generator's beam
is centered on the Imager's conversion screen. In Figure 2.6, the imager is oriented so
that the bottom of the conversion screen is11cm above the ground surface. The X-ray
generator must be elevated for the X-ray generator's beam to be centered on the
screen.

2.2 Set-Up Procedures
1. Remove the ARS components from the shipping containers.

2. Place the Control Unit on a desktop (or other stable work area) as far from the
imaging area as is practical.

3. Place the Imager as close to the object to be imaged as possible. Refer to the
previous X-RAY GENERATOR AND IMAGER section for more information.

4. Place the X-ray Generator level with, and perpendicular to, the Imager's
screen. Verify the X-ray Generator's Exposure Selector (LED at the back of the
Inspector 200handle) is 99 pulses.

5. Run the 3-meter gray cable from the appropriate connector on the X-ray
Generator to the appropriate connector on the Imager. This gray cable passes
signals from the Imager to the Generator.

6. Run the 20-meter black color-coded cable from the appropriate connector on
the Imager to the connector identified as "Imager" on the Control Unit. This cable
supplies power to the Imager, carries the X-ray generator control signal and
routes the image back to the Control Unit.

CAUTION: When unreeling the cable, be sure to grasp the cable rather than the
connector and unreel the cable before connecting the cable to either the Imager or
the Control Unit.

7. The Golden Engineering Inspector 200 X-ray generator is battery operated;
insert an operable battery.

8. The ARS Control Unit can plugged into a 110 VAC, 60 Hz or 220 VAC, 50 Hz
power outlet using the power cable provided, to an external 9.5-28 VDC
generator, or can be battery operated.

9. The X-ray generator power key must be turned to the "ON" position before X-
rays can be produced.
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10. The Control Unit's interlock key must be turned to "STANDBY" before any X-
rays can be produced.

11. Make sure that all personnel adhere to applicable radiation safety distance
recommendations for field operation (see Chapter 1 for more information).

2.3 Power Considerations
The ARS is configured with a power-saving feature that will make the screen blank
after a period of two to four minutes of non-usage of the system. Pressing the shift
key or moving the mouse will reactivate the screen. Do not press any other key as it
may perform an undesirable function. The ARS Control Unit will automatically switch
between internal battery, US standard110 VAC, and international standard 220 VAC
line power. The system is frequency insensitive between 45 and 65 Hertz. The Control
Unit also powers the ARS Imager, therefore no special power consideration is required
for the Imager. The ARS Control Unit can directly accept external DC power input that is
connected to the Control Unit's connector labeled DC IN see Figure 2.3. Also, An
optional 3 meter cable (Part VBC-12) is available that connects the Control Unit to a 12
VDC automobile cigarette lighter receptacle. Lastly, an optional cable with battery clip
ends is available for connecting the Control Unit to an external battery. The Golden
Engineering Inspector 200 X-ray generator is powered by a rechargeable14.4 VDC
internal battery pack. Refer to the manufacturer's operation manual for more
information.

2.4 Battery Power Considerations
A 10.8-Volt rechargeable battery is located in the hinged compartment below the
keyboard of the Control Unit. A fully charged battery permits about 60 minutes of
operation. The battery in the Control Unit will automatically begin recharging as
soon as the unit is plugged into a line power outlet, and will take approximately 8
hours to completely recharge. (For instructions on using the Span DRC22-1535
recharger, see Appendix A. The Control Unit does not need to be powered on for the
battery to recharge. To access the battery compartment, first loosen (do not remove)
the two thumb screws in the front of the hinged battery compartment panel see Figure
2.4. The compartment swings open from the top. To remove the battery, pull the fabric
battery lifting strap and the battery will lift out. To install a battery, first note the slots in
the battery and align them with the metal flanges in the battery compartment. Put
the slotted end of the battery in first, then glide the battery horizontally until
the flanges enter the slots and the battery drops into the recessed battery holder.

CAUTION: Improper insertion of the battery, while difficult, is possible and can
render the system useless if the battery connector is bent. Please be careful when
inserting the battery. The external battery charger can charge optional spare batteries
outside the Control Unit. Fully recharging a discharged battery with an external rapid
charger takes about 3 hours. Table 2.2 provides information about the battery charge
indicator and the LED charge status of the battery:

CAUTION: When the red LED starts to flash, images should be saved and the system
should be shut down immediately.
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2.5 The Main Menu
When power to the Control Unit is turned on, the computer will automatically enter
the ARS software's Main Menu, which is in a familiar Windows-based style shown in
Figure 2.7. The system is then ready for imaging.

2.6 Acquiring an Image To acquire an image, click on Acquire on the Main Menu. This
activates the pull-down menu shown in Figure 2.8. Figure 2.9 shows a dialog box that
contains a warning "Ensure the radiation area is clear before proceeding!" to remind the
user to clear the imaging area of personnel before proceeding.

2.7 Editing an Image
After acquiring an image, the user can then select other pull-down menu options to
enhance or edit the image. If the image just acquired is under- or over-exposed, or
the features of interest in the image are not properly oriented for definitive evaluation,
another image may be acquired after adjusting the exposure duration, or rearranging
the placement of the X-ray generator or Imager relative to the target object. Resetting
the X-Ray Pulses option in the Acquire dialog box (refer to Chapter4 on Imaging
Techniques) will help with acquiring a better image. An acquired image can be visually
enhanced using the functions found in the Modify pull-down menu. Most images will
benefit from the Modify enhancements offered in the Modify menu. The options under
the Annotate pull-down menu can be used to label or comment on features of interest,
or to date and title the image. Note that image data and time are kept with the image
header, visible via the Show Header Info menu option. Once the quality of the image is
satisfactory, the image can be stored to hard disk or floppy disk using the options found
in the File pull-down menu.

Chapter 3 - The ARS Menu Options

3.1 The Main Menu
As each menu bar function is selected, the definition of each selection is displayed
left of the status bar at the bottom of the screen. Refer back to figure 2.7 to
review the diagram of the control unit display screen. The left side of the status
bar shows specific function keys or key combinations and the action they initiate.
The middle of the status bar indicates which of the two images (Original or Modified
buffers) is currently displayed. The right side provides information on cursor
location in pixels, and pixel gray scale value (image brightness) at that location.
Many of the functions on the Menu Bar and pull-down menus have corresponding icons
located in the icon toolbar (along the right side of the screen). Table 3.1 lists the
functions, starting from the first menu item, and the corresponding options for
accessing that particular function.

3.2 The Acquire...Function
ACQUIRE...
An Acquire... request can be canceled at any point by selecting Cancel or pressing
the ESC key twice. This will return the user to the Main Menu. When the Acquire
option table 3.2 is selected, the X-ray Generator pulses after the preset time delay
and an image is acquired. The system then returns to the Main Menu and the image is
displayed on the screen (Figure 3.1).When a Delay Timer value other than 0 seconds
has been set, a message box appears on the display with a counter that counts down
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the preset number of seconds, see Figure3.2. Cancel may be selected to abort image
acquisition at any point during the count down. Once the Delay Timer has been
changed that value becomes the new default. The Delay Timer value automatically
resets to 0 when the program is restarted. *Golden Engineering recommends not firing
more than 99 pulses in a five-minute period to minimize the likelihood of the X-ray tube
overheating in the Inspector 200 or theXR200 X-ray generators.

SUM...
The Sum function can be used to accumulate more than 99 pulses for an image. The
first image is taken, then Sum is used to collect a subsequent image, and then it is
added to the existing image, and may be repeated as the operator desires. This is
useful when the object being imaged is thick or made of a material denser than
typical objects. Selecting Fire and Sum X-Ray captures the first image. The Acquire
dialog box appears again automatically. If the first image was adequate, select
Cancel. If not, set the option values and select Fire and Sum X-Ray again. This will
add the two images together.

CAUTION: Golden Engineering recommends not firing more than 99 pulses in a
five-minute period to minimize the likelihood of the X-ray tube overheating in the
Inspector 200 or the XR200 X-ray generators.

3.3 The File Menu
OPEN...
To retrieve a previously stored image from the hard drive or a floppy disk, select
Open...from the File menu. When Open... is selected, a dialog box is displayed on the
screen as shown in Figure 3.3. Select the desired file by double clicking on the
filename, or by clicking on the filename, then clicking Open... The file may also be
selected via the tab, arrow, and return keys. When the Enable Preview box is
selected, a thumbnail image of the file will be displayed.

QUICK SAVE
The Quick Save option allows images to be stored without specifying a filename. The
system selects an automatic filename, which is a function of the system date and
time. Specifically, the first two numbers in the filename will refer to the day of
the month, the next two will be the hour of the day, the next two will be the minute,
and the final two will be the second. This is done to minimize the possibility that
two images will have the same name. It is recommended that the image files be
renamed as soon as possible after they have been stored so that they can be given
filenames that are more descriptive than the computer generated names. Select Quick
Save. A dialog box appears with the automatic filename and the option to save or
cancel by selecting Yes or No. (Figure 3.4).

SAVE AS...To store an image (see table 3.3) on the hard drive or a floppy disk under a
user-specified filename, select Save As... When this option is selected, a dialog box is
displayed on the screen as shown in Figure 3.5. Select the desired location for the file
and provide a descriptive name. Then select OK or Cancel.

Note: The new directories may be created within this window via the icon with the
folder and the asterisk. The folder with the arrow ascends a directory, and the icon
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on the right shows the dates and time for the tests listed. Please save all files in
TIFF format to maintain compatibility and to preserve all the ancillary data with the
images.

PRINT
Selecting the Print function activates the print dialog box. Set options for printing
as in normal Windows � applications. (Figure 3.6)

PRINT SETUP
The Print Setup dialog box provides the user with format options for the printed
output. Options for printing setup are as in normal Windows, applications.
 (Figure 3.7)

EXIT
When Exit is selected, the ARS program is terminated. All unsaved buffers are
discarded.

3.4 The Display Menu
The options provided in the Display menu allow images to be enhanced so that
evaluation is easier. None of the functions in the Display menu will change the image
permanently. Figure 3.8 shows the Main Menu with the Display pull-down menu
activated.

ZOOM
When Zoom is selected, a dialogue box appears with three sizing options. Selecting
the options x1, x2 or x4, will enlarge the image by a factor of one or two or four.
Scroll bars will appear on the right and bottom of the screen for panning and
scrolling through the image. To zoom back or un-zoom, the user has three options:
select Zoom and x1, select the magnifying glass icon containing the minus sign and
click on the image, or use the Page Down key on the key board.

PALETTES
Selecting any of the Palette options changes the display colors of the images. These
color schemes may improve the appearance of details and, therefore, make the
evaluation of the image easier (Figure 3.9).

DEFAULT
This option return the image to a positive view of the image.

INVERTED GRAYSCALE
This option provides a negative view of the image (Figure 3.10).

INVERTED RAINBOW
This option provides a reversed-color view of the image.

RAINBOW
This option provides a colored view of the image.
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AUTO-STRETCH
This option allows the ARS processor to adjust automatically the brightness and
contrast of the image. It will select settings that frequently maximize image
clarity.

CONTRAST STRETCH
This function is used to change the distribution of the color or gray-levels of the
image. A dialog box will appear on the screen over the image. This will contain a
histogram with two thin blue bars located along its left and right sides. The
histogram is a graphical display showing intensity (along the horizontal axis) and
their corresponding number of pixels with that intensity (along the vertical axis).
Image contrast and brightness can be altered by adjusting the location of the blue
bars within the histogram (Figure 3.11). The blue bars can be repositioned along the
horizontal axis using several methods. The position of an individual blue bar can be
changed by clicking once on the bar, moving the mouse to the left or right to the
desired position, and then clicking a second time. Both bars can be moved
simultaneously (to capture a more precise array within the histogram) by clicking
once within the blue bars and then using the arrow keys to move the selected area
along the horizontal axis. Contrast Stretch does not change the original data in the
display memory buffer. This allows the user to exit the Contrast Stretch function
with the appropriate contrast values still in effect, and continue to acquire new
images and perform other tasks.

Note: Contrast Stretch and Grayscale Invert act only on the displayed image. When
images are stored to disk, the underlying data will not be stretched or inverted, and
the original appearance may be restored by selecting the "Default" pallet.

GRID OVERLAY
ARS provides two methods for measuring the size and location of features of interest
in the displayed image. The Grid overlay function overlays a one-cm square grid on the
screen over the image (Figure 3.12). This allows the user to quickly estimate device
dimensions and determine the positioning of device components within a package.

DISTANCE MEASUREMENT
The Distance Measurement function allows the user to place two points, and measures
the distance between the cursors in inches or centimeters. By selecting Distance, a
crosshair cursor appears. Move this cursor to the desired first location, and click
to set the position. Next, moves the cursor to the second location. As the cursor
is moved to the second point, a mobile line is displayed. A second click sets the
second mark and the distance between the two set points is displayed in a message
box as shown in Figure 3.13

SHOW
This function gives two options: By selecting Image Header, a box appears on the
screen that displays the date and time that the particular image was acquired. It
also shows the serial number of the Control Unit used, and whether the image has been
modified or not (Figure 3.14).Cumulative Pulse Count displays the total number of
pulses fired by the X-ray generator since the last reset (Figure 3.15). This can be used
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to give an indication of remaining battery, or X-ray tube life. There is an option to reset
the count. This should be used when a new X-ray tube is installed. See the X-ray
generator operator's manual for more details. The expected life of the tube in the
Golden Engineering XR200 is 35,000 pulses.

Note: The Cumulative Pulse Count function records the number of pulses requested,
not the number actually fired.

SWITCH BUFFERS
There are two image memory buffers in ARS. The original image data acquired by the
system are stored in the Original Buffer. The image resulting from processing is
stored in the Modified Buffer. Alternating between the two buffers is done with the
Switch Buffers function. The current buffer on the display is highlighted in the
Status Bar

CLEAR BUFFER
This function erases the image located in the display buffer, clearing the display.

3.5 The Modify Menu
The processing functions in the Modify menu irreversibly change the data in the images.
These functions act on the original image data located in the Original Buffer, and
produce a modified image, which is in turn stored in the Modified Buffer. The buffer
being displayed is automatically switched from the displayed Buffer to the displayed
Buffer when these functions are performed. A modified image can be saved to floppy
disk independent of the original raw data (Figure 3.16)

REGION OF INTEREST (ROI) PROCESSING
When ROI Processing is activated, the cursor changes to a crosshair. Clicking, moving
the crosshair and clicking again on the image defines the region-of-interest (ROI).
Enhancement functions can then be applied and will only affect the ROI. When this
function is selected, the Display and Modify functions are applied to the data in the
selected ROI, rather than on the whole image. (Figure 3.17) shows the ROI Toolbar
below. Title labels have been provided here to identify the icons.)

ANNOTATE
The Annotate function allows for the addition of text and lines to the displayed
image. When Text is selected, another submenu appears which gives the option of
selecting either Black or White text. A dialog box is then displayed allowing text
to be entered. A rectangle showing the text is then displayed together with a hand
cursor. This cursor allows positioning of the text rectangle. The text is placed in
a white or black rectangle (background) so that it is always visible, independent of
the shade of the background. An example of black text on a white background is shown
in Figure 3.18 below. The Lines option allows straight lines to be drawn on the displayed
image. Once Lines is selected, the same color option of Black or White can be made,
and across hair cursor appears. Move this cursor to the desired first location and set the
first point by clicking once. Next, move the cursor to the second location. As the
cursor is moved to the second point, a rubber-band line is displayed between the
first point and the current location of the cursor. A second click sets the second
mark and the line is drawn between the two set points as shown in Figure 3.19.
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SHARPEN
This operation makes edges pronounced and can improve the resolution of the image.
It makes lines and edges in an image much more defined. There are three options to
this function: Fine, Moderate, and Extreme. The Fine option will slightly sharpen
the image and can be used when a subtle adjustment is necessary. The Moderate
option is more obvious and improves the clarity of the image without drastically
increasing the apparent noise level (for an explanation of noise, see the following page).
The Extreme filter will dramatically increase the sharpness of the image but because the
noise will also be increased in the processed image, it produces a "grainy" effect.(Figure
3.20).

SMOOTH
These filters essentially produce the opposite effect of the Sharp functions. The
filters smooth out edges, producing a slightly smoother, softer image, reducing
speckle and noise. As with the Sharpen function, there are three options: Fine,
Moderate, and Extreme. The Moderate option also has an icon button and function key.
Applying one of the Smooth filters will slightly reduce the resolution of an image.
(Figure 3.21).

NOISE REDUCTION
This function has three options in its submenu: Average, Median, and Despeckle. Noise
in an image is pixels with randomly distributed brightness levels. Noise Reduction
will help filter out problem areas such as spots in an image. Average replaces the
center pixel of a three-by-three array with the average of those nine pixels. Median
replaces the center pixel of the three-by-three array with the median value of those
nine pixels. Despeckle removes 1-pixel speckle from the image and shrinks some
larger speckles (Figure 3.22).

EDGE DETECT
This function has three options: Horizontal, Vertical and Diagonal. As each option is
selected those particular edges in the image will be displayed as white lines on a
black background. This tool may be helpful in locating items with characteristic
shapes in a cluttered image by removing the shading and features. Figure 3.23 shows
the same image of a pipe bomb with the horizontal edges in the image shown in white.
The menu is also selected to show its location and options.

EMBOSS
This function will make an image appear raised or stamped by suppressing the shading
within the image and tracing its edges with black or white (Figure 3.24).

ADD IMAGES
The Add Images feature allows the user to add images together to enhance the user's
ability to discern objects within dense containers or housings. This feature is
useful when the highest pulse rate setting (99) provides a dim image. This feature
allows the user to add multiple 99, pulse images together. The user must begin the Add
Images process with the original image located within the Original Buffer and the image
to be added located within the Modified Buffer. (The user may switch between the
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buffers using the F7 key.) While viewing the Original Buffer, select the Add Images
function to add the images together. The resulting image appears in the Modified Buffer.
To view the combined images, select the Automatic Stretch function from the Display
menu. Automatic Stretch should make the image viewable, most of the time.
Note: The Add Images function clips the maximum pixel intensity to 255.

SUBTRACT IMAGES
The complement of the Add Images function, the Subtract Images feature allows the
user to subtract images from one another. This feature can be used to remove
system-induced artifacts in images by taking a background image and subtracting the
image of the object. The user must begin the Subtract Images process with the original
image located within the Original Buffer and the image to be subtracted located within
the Modified Buffer. (The user may switch between the buffers using the F7 key.) While
viewing the Original Buffer, select the Subtract Images function to subtract the images.
The resulting image appears in the Modified Buffer. To view the combined images,
select the Automatic Stretch function from the Display menu. Automatic Stretch should
make the image viewable, most of the time.

Note: The Subtract Images function truncates resultant pixels that would be less
than zero to zero.

HISTOGRAM EQUALIZE
This function makes a non-linear change to the image, to enhance more subtle details
than Auto Contrast. It automatically adjusts the brightness of pixels to balance the
brightness across the range of brightness within an image to enhance visual
interpretation (Figure 3.25). In some cases, Histogram Equalize may provide a better
enhancement of the image than Auto Contrast.

ROTATE IMAGE
This function allows the image to be rotated. Three options are available within
Rotate Image. +180 Degrees allows the image to be rotated 180 deg.and is useful when
the image was acquired with the Imager set upside down (Figure 3.26). Flip Left-Right
and Flip Top-Bottom are additional options to reflect the image left-to-right or
top-to-bottom.

3.6 The Preferences Menu
The Preferences pull-down menu allows the user to alter the behavior of the user
interfaces. Figure 3.27 shows the Preferences pull-down menu. A checkmark next to
each menu item indicates whether or not the item is activated Checks next to the menu
items indicate they are selected as preferences.

ICON BAR
This option shows or hides the Icon Toolbar located at the top of the screen, just
below the Main Menu bar. Removal of this toolbar allows more of the image to be
viewed without scrolling or panning. The system will revert to showing the icon bar
when the application is restarted.

STATUS BAR
This option shows or hides the Status Bar, which is located across the bottom of the
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screen. The system will revert to showing the icon bar when the application is
restarted.

DISTANCE IN CM
This option toggles between measurement units in centimeters or inches to suit user
preference. The system will retain this user preference when the application is
restarted. The Distance Measurement and Grid Overlay are affected by this setting.

BUFFER PROTECTION
This option turns the buffer protection on and off. A check mark indicates its
status. When on, the system will prompt when a buffer is about to be discarded
before that buffer has been saved. When not on; no warnings are given. The system
will retain the buffer protection on when the system is restarted.

INVERT ALL IMAGES
This option allows the user to select a negative or positive view of the images. A
check mark indicates its status. The system will revert to non-invert function when
the system is restarted.

AUTOMATIC STRETCH ALL
Choosing this option sets ARS preferences to automatically optimize the contrast of
the all displayed images. (To manually set the contrast for individual images, use
Contrast Stretch under the menu option.) The system reverts to the non-automatic
stretch when the system is restarted.

3.7 The Help Menu
The Help pull-down menu allows the user to display information on system operation.

HELP
Selecting the Help function brings up a dialogue box containing the contents of this
user manual.(Figure 3.28).

KEY MAP
Key Map: When this function is selected, a message box containing a list of the
function keys with their corresponding functions is displayed on the screen as shown
in Figure 3.29.

ABOUT
This function activates a message box containing information on the ARS software
version installed on the system (Figure 3.30).

Chapter 4 - Imaging Techniques

4.1 Target Density and Exposure Duration
EXPOSURE DURATION
The ARS (figure 4.1) allows the user to adjust the X-ray exposure duration (number of
pulses) before acquiring an image. This is useful when the target objects vary by
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thickness and composition. The X-ray Generator's exposure duration is adjusted using
the X-Ray Pulses input field of the Acquire... function dialog box as described in
Chapter 2. The default acquisition of 7 pulses should be used when imaging very thin
or light-weight objects which do not readily absorb X-rays. Longer exposure time
settings (a higher number of pulses) should be used if the target object is not

sufficiently penetrated with 17 pulses. The X-Ray Pulses feature allows the operator
to gradually add pulses to a captured image until the object is sufficiently
penetrated (refer to Chapter 3 for more information about the SUM function).
Setting the X-Ray Pulses higher than necessary will result in a saturated (pure
white) image, or saturated areas of the image. To avoid this, set the X-Ray Pulses
to a lower exposure setting, then increase or decrease it as necessary to achieve a
bright image that is free of saturation. An insufficiently long exposure time for an
object will result in a dark image that provides little or no information about the
internal structure or content of the object.

Note: The best way to achieve a satisfactory image is to refer to the histogram
Contrast Stretch feature under the Display... menu. If the histogram graph is
bunched to the left, the number of pulses should be increased. If the histogram
graph is bunched to the right, it is likely that the number of pulses was set too
high.

DISTANCE
Another more subtle method for adjusting the target X-ray illumination is to vary the
distance between the X-ray Generator and the Imager. Although a distance of
approximately 60 to 90 cm between the X-ray Generator and Imager is recommended
to provide a sharp, proportional image, this separation distance can be decreased to
penetrate thicker or denser materials. Regardless of the distance between the X-ray
Generator and Imager, it is always best to place the object as close to the center of
the Imager screen as possible, which will result in maximum penetration and
resolution.

Note: An object located between the X-ray Generator and Imager will produce an
enlarged image. This is because X-rays are emitted radially out from a small spot
(diverging), and the X-ray "shadow" of the object is projected onto the Imager
screen. Therefore, the further the object is away from the Imager and the closer it
is to the Generator, the larger its projection, and, consequently, the larger its
features will appear in the acquired image. Objects that are closer to the Imager
will more closely reflect their true dimensions. Objects that are further from the
Imager will measure larger than they actually are. Objects such as thick wood and
aluminum, thin steel, thin plastic or card board enclosures can be imaged easily by
adjusting the distance between Generator and Imager and varying the exposure
duration settings. The Add Images function allows the operator to add separately
acquired images together, to overcome the X-ray generator's limit of 99 pulses. This
increases the system's ability to image steel and other denser materials.

4.2 X-Ray Beam Filtering
X-ray generator beam filters may be used to enhance the quality (resolution and
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contrast) of the image, thus improving the visibility of subtle features. A filter
is generally a thin metal sheet placed over the X-ray generator's beam aperture.
This filter, by absorption and scatter, removes a fraction of the low energy X-rays
that may be contributing to image noise due to scattering. The type and thickness of
the filter used depends on the thickness and composition of the imaged object.
Examples of recommended beam filters for thin or lightweight objects: * 0.12 - 0.25
mm copper filter * 0.51 - 0.762 mm a1uminum filter. Examples of recommended beam
filters for denser materials: * 0.51 mm copper filter* 1.27 mm aluminum filter

Chapter 5 - Procedures for Modem Use

5.1 Sending and Receiving Files On the Receiving Machine:
Start Communications Center
Start Terminal (AA TR and MR lights will glow on the Control Unit)
The system is now ready to receive
On the sending machine:
Start Communications Center
Start Terminal (AA TR and MR lights will glow on the Control Unit)
The system is now ready to send
To dial, press the ALT and D keys simultaneously, type the extension and press
Enter
The following information will appear on the screen:
Sending: ATDT9255
Receiving: RING
ATA
CONNECT 336600/ARQ
Sending: CONNECT 336600/ARQ
On the sending machine, selecting Pg Up initiates a transfer
Click OK for z modem transfer
Move to the directory where the images are to be sent
Double click on each image to be sent
Click Send List
Both machines will track the file transfer. Each file transfer will take
approximately one minute.
Choose the Terminate Current Session and reset modem button on the sending
machine.
Both machines will disconnect.
Files should appear in c:\images\download on the receiving machine. It is
possible, under rare circumstances, to damage the phone system when
connecting an analog device, such as this modem, to the phone system. Please
check with the local technician to very operability.
Be sure to shutdown, restart, and verify sending and receiving from both
machines.



For Official Use Only

For Official Use Only

Appendix A - Maintenance

A1. Preventative Maintenance
SYSTEM CARE AND CLEANING
The ARS should be stored and transported in the transit cases provided with the
system. The ARS has no special periodic maintenance requirements other than battery
charging and image quality checking. The unit may be cleaned using a damp cloth and
mild detergent, but care must be taken to prevent water from entering sensitive
electronic areas. The flat panel display may be wiped off using a damp, lint-free cloth
while the power is off.

BATTERY MAINTENANCE
The ARS internal battery must remain charged to ensure that the system is ready for
deployment at a moment's notice. The ARS incorporates a built-in battery charger
that will recharge a fully discharged internal battery in approximately 8 hours.
The battery may be easily removed and replaced by the user. (See section 2.4 for
details on battery access.) Over time, batteries on the shelf will gradually lose
their charge. It is recommended that spare batteries be recharged every two months
of storage. Spare batteries may be charged/recharged using the external charger
(instructions follow below).Replacement batteries must conform to the specification for
an DR-35S 10.8 V 3800mA-hr battery. A 3800 m A-hr charger is acceptable, but NiMH
is the only chemistry that is acceptable.

OPERATING THE SPAN RECHARGER
Plug the wall adapter into an outlet and insert the plug end of the power cable into
the jack on the rear of the DRC22-1535 Recharger. Insert one or two DR35 batteries
into the pocket(s) on the top of the Recharger. Lights near the pockets will illuminate to
indicate the status of the batteries as
follows:

Off No battery detected
Red Charging
Green Fully charged
Yellow Standby
Red Flashing Error

The DRC22-1535 Recharger will completely charge a DR35 in about 75 minutes.) If two
batteries are inserted, they will be charged sequentially. The light of the second
battery will be yellow, indicating a standby condition. The second battery will
automatically commence charging once the first battery is completed. he DRC22-1535
monitors battery temperature and will not commence charging a pack if it is outside a
temperature range of 10deg.C - 45deg.C. Any pack that is outside this range will also be
indicated by a yellow light. An error indication will be given if the battery terminals are
shorted or if the battery fails to properly take a charge. If your DRC22-1535 charger
does not function as expected, check the following: Make sure the wall adapter is
properly connected. Make sure there are no foreign objects lodged in the pockets. Make
sure the batteries are installed so that they properly mate with the connector in the
bottom of the pocket.
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IMAGE QUALITY MEASUREMENT AND CHECK
Included with each system at shipment is a calibration image, in the directory:
C:\images\calibration This is an image of some small wires and a resolution "star"
gauge. It is suggested that the user periodically check system operation by duplicating
this image. The image is 60 cm away from the X-ray source, and the image
is taken using 7 pulses with the items taped to the front of the imager.

DISK SPACE
Hard disk and floppy disk file space can be recovered by deleting old images that are
no longer needed, or ones that have been backed up to an external hard drive. Use the
Delete option in the Windows Explorer application that can be accessed through a
right-click on the Start button on the bottom of he screen. See Table A1.1 for ARS
Spare Parts Maintenance Procedures.

Appendix B - Troubleshooting

B1. Repair Instructions
The ARS is warranted for one year from the time the unit is shipped from SAIC.
Return inoperative Control Units, Imagers, and/or cables including a description of
the symptoms and authorization for repair service to:

Science Applications International Corporation (SAIC)
Attn: ARS Manufacturing Manager
16701 West Bernardo Drive
San Diego, California 92127 (800) 962-1632
 For system support or information:
E-Mail Radeco@cpmx.saic.com, or Call (800) 962-1632.

B2. Troubleshooting Guide
see Table B2.1. If none of these corrective actions fix the
problem, send an E-mail or call for system support (see Paragraph B1).

B3. Potential Error Messages
see Table B3.1. Review the Following Text Messages to locate the reason for the error
message. If none of these definitions assist in determining the problem, send and E-
mail or call for system support (see ParagraphB1).

B4. Variable Text Messages
see Table B4.1.Review the following Variable Text Messages to locate the reason for
the error message. If none of definitions assist in determining the problem, send an E-
mail or call for system support.

Appendix C - ARS Radiation Survey Measurements

C1. Introduction
SAIC's ARS X-ray Inspection System uses a Golden Engineering Inspector 200 X-ray
generator. This device emits X-Radiation, which can be harmful to people if they
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receive excessive exposures. The use of such systems is regulated by both state and
federal regulations. The use of X-ray generators outside of cabinets and shielded
rooms to form images of objects is termed Field Radiography. Most states require
operators of such systems to be trained in, and demonstrate an understanding of, the
following subjects: Characteristics of X-Radiation Units of radiation dose Radiation
hazards Radiation levels from radiation machines Methods of controlling radiation
exposure: Time, Distance and Shielding Use of Radiation Survey Instruments:
Operation, Calibration, and Limitations Radiation Survey Techniques Characteristics
and use of personnel monitoring equipment Use of radiation machines in radiography

C2. Dose Measurements
Inspector 200 X-ray Generator dose measurements CAN be made using: Integrating
ionization chambers Film badges Pocket ionization chambers (PICs)Thermo-
luminescent dosimeters (TLDs) because these measure the energy liberated in
the detector from the time the instrument was zeroed. Inspector 200 X-ray Generator
dose measurements CANNOT be made using: Pulse counting instruments such as a
Geiger-Mueller (GM) tube. These instruments will only count one event in the short time
(50 nanoseconds) of the X-ray pulse. Survey meters such as an ion chamber operating
in a dose rate mode. The time responses of these survey meters are too slow to
measure the dose delivered to the instrument in the relevant time frame. Radiation dose
measurements were made around the ARS X-ray inspection system using a Victoreen
450B survey meter operated in the integration mode. An Inspector 200 X-ray generator,
the processor to the Inspector -200, was used for these measurements. The X-ray unit
was set to capture images at the default 17 pulses per image. The generator and
imager were separated by 69 cm. Images were taken to assess the dose rate received
by the survey meter while it was directly in the beam. In addition, scattered dose was
measured while a 10 x 10 cm oak timber was directly in the beam. The oak timber
provides a reasonable upper estimate of the scattered radiation. Metallic objects will
produce roughly the same amount of scattered radiation but will absorb more of it,
giving a smaller amount of scattered radiation than the high-density oak. The survey
meter was first zeroed by turning the unit off. The meter was then turned on and the
instrument placed in the integrate mode. When the meter reached a dose of more than
1 mR, it was re-zeroed by turning the meter off. (The incremental dose recorded in the
integrate mode is 10 � R for readings less than 1 mR and 1 mR for readings greater
than 1 mR.)The dose per exposure was calculated by subtracting the reading before the
exposure from the reading after the exposure. Measurements made in the beam
resulted in a dose of 10 mR per image at a distance of69 cm from the generator and 17
pulses per image. This corresponds to a dose rate of3.1 mR per pulse at 30 cm from
the generator. This dose is consistent with the dose of 3.5 mR per pulse at 30 cm from
the generator reported by GEI. This agreement confirms that the survey meter,
operated in the integrate mode, is measuring the dose correctly. (The meter is normally
calibrated while operating in the dose rate configuration.) (It should be noted that a
Victoreen 450P survey meter cannot be used to measure doses out of the beam.)The
dose rate outside of the beam was measured by exposing a 10 x 10 cm oak timber
directly in front of the imager to produce scattered radiation. Data were obtained by
forming images of the wood and using the dosimeter in the integrate mode. It appears
that the radiation scattered from the wood dominates the measured dose. To investigate
the shielding effectiveness of normal interior walls to the penetration of the scattered
radiation, the dose was first measured with no shielding present. Two 1.27 cm thick
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sheets of drywall material were then inserted between the generator and scatterer and
the detector. The dose per image decreased by a factor of 2. Normal walls will also
include wood framing and other interior material such as electrical cabling and normally
will be at an angle to the scattered radiation. A factor of 2 reduction in the scattered
dose caused by normal interior walls should be a conservative estimate. Concrete walls
will provide much greater attenuation. One can estimate that a 10 cm thick concrete wall
will reduce the transmitted dose by a factor of 50 (Attenuation A = 0.02).

C3. Legal Dose Limitations
OCCUPATIONAL EXPOSURES
An occupationally exposed individual is limited to receiving 5 Rem of radiation per
year. If the operator remains over 1.8 meters from the objects being inspected it,
the operator would need to take more than 1,000,000 images in a year to reach the
legal limit for occupationally exposed personnel. For minors, the occupational dose
limits are 10% of the annual dose limits for adult workers. For declared pregnant
workers, the dose to an embryo/fetus during the entire pregnancy must not exceed 500
mRem. Furthermore, a reasonable effort must be made to ensure that exposures to
declared pregnant workers are essentially uniform throughout the pregnancy.

GENERAL PUBLIC
The dose limit for uncontrolled areas is 2 mRem in any one hour and 100 mRem in a
year. It was shown above that it is fairly easy to obtain 2 mRem in the beam in
short periods of time. It was also shown that it would only take 5 images at a
distance of 3 meters, or 10 images if there is an intervening interior wall, to reach
this level. At a distance of 1.8 meters from the scatterer, out of the main beam, it
would take 2300 images to reach the 2 mR dose limit see (table 5).

ALARA
In addition to the legal limits mentioned above, both state and federal laws require
that radiation doses to both occupationally exposed individuals and to the general
public be held to levels that are as low as reasonably achievable (ALARA). If it is
reasonably easy for an operator to stand behind a wall when he is making exposures,
this must be done. In addition, if a shield is reasonably easy to incorporate into a
setup, it must be included. It should be noted however, that the operator must maintain
control of the region of the X-ray beam out to a distance of at least 1.5 meters from the
generator when the generator is fired. This will impose some limits on where the
operator can be positioned.

C4. Monitoring
All of the states in the US control the use of X-ray generators. Additionally, the
FDA regulates the use of X-ray generators in cabinets and shielded rooms. Most states
require that personnel radiation dosimeters be provided to, and used by, all personnel
who conduct Field Radiography. Most states also require that physical radiation surveys
be performed for each set up and that the results of these surveys be recorded. It is
likely that a two-point radiation survey would be sufficient if one has a survey meter like
the Victoreen450B.

C5. Utilization Log
Each user must maintain records of the use of the X-ray source. This utilization log



For Official Use Only

For Official Use Only

must include: * The name and serial number of the machine. * The location, date,
and the identity of the individual operator for each use. * The number of images
produced or the number of pulses produced for each use. Refer to the sample
(Utilization Log) shown on the following page.

C6. Source Registration
Most US states require that users of X-ray sources, such as the Inspector 200 X-ray
generator used in the ARS, register these sources with the Department of Health. SAIC
strongly recommends that all purchasers of X-ray sources, regardless of the state or
country where they are located, pursue registration of these devices with the
appropriate local agency.

C7. References
A1. Radiological Health Handbook, Bureau of Radiological Health, 1970, U.S.
Department of Health, Education, and Welfare, Bureau of Radiological Health,
Rockville, Maryland, p 151, 152.

C8. Dose Control Tables
Table C8.1 lists the conditions that are necessary to restrict the dose at the
indicated positions to less than 2 mR. Column 1 gives the number of images that the
operator expects to take in a given location. The second column lists the distance
along the beam path (and a +/-20deg.cone around the beam centerline) that must be
controlled to ensure that all regions outside of this region receive less than 2 mR.
The third column lists the thickness of concrete that one would need to have behind
the imager, .9 meters from the generator, for the region in back of the wall to be
considered as uncontrolled. The fifth column yields the thickness of lead that would
have to be placed over an interior wall to allow the area behind the wall to be
considered as uncontrolled. Table C8.2 is similar to (Tables C8.1) except it lists the
conditions that are necessary to restrict the dose at the indicated positions to less than
100 mR. FigureC.1shows the ARS Safety Zones.

C9. State Radiation Safety Contact List

Alabama: Kirk Whatley, Director
Division of Radiation Control
State Department of Public Health
RSA Tower
PO Box 303017
Montgomery, AL 36130-3017
Phone: (334) 206-5391
Fax: (334) 613-5387
Email: kwhatley.adph.state.al.us

Alaska: Kate Coleman, Chief
Radiological Health Program
AK Dept. of Health & Social Services
P. O. Box 110613
Juneau, AK 99811-0613
Phone: (907) 465-3256
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Fax: (907) 465-2088
Email: katec%health@state.ak.us

Arizona: Aubrey V. Godwin, Director
Arizona Radiation Regulatory Agency
4814 South 40th Street
Phoenix, AZ 85040
Phone: (602) 255-4845
Fax: (602) 437-0705
Email: gdwa23a@prodigy.com

Arkansas: David D. Snellings, Jr., Director
Division of Radiation Control
Arkansas Department of Health
4815 W. Markham, Slot #30
Little Rock, AR 72205-3867
Phone: (501) 661-2301
Fax: (501) 661-2468

California: Edgar D. Bailey, Chief
Radiologic Health Branch
Dept. of Health Services
P.O. Box 942732
Sacramento, CA 94234-7320
Phone: (916) 322-3482
Fax: (916) 324-3610
Email: ebailey@hw1.cahwnet.gov

Colorado: Robert M. Quillin, Director
Laboratory and Radiation Services Division
CO Department of Public Health & Environment
8100 Lowry Blvd.
Denver, CO 80220-6928
Phone: (303) 692-3038
Fax: (303) 343-3697
Email: robert.quillin@state.co.us

Connecticut: Radiation Control Division
Dept. of Environmental Protection
165 Capitol Avenue
Hartford, CT 03106
Phone: (203) 566-5668

Delaware: Allan Tapert, Program Administrator
Office of Radiation Control
Division of Public Health
P.O. Box 637
Dover, DE 19903
Phone: (302) 739-3787
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Fax: (302) 739-3839
Email: atapert@bangate.state.de.us

Florida: William A. Passetti, Chief
Florida Department of Health
Bureau of Radiation Control
1317 Winewood Blvd.
Tallahasse, FL 32399-0700
Phone: (850) 487-1004
Fax: (850) 487-0435
Email: bill_passetti@hcsgwy.hcs.net

Georgia: Thomas E. Hill, Manager
Radioactive Materials Program
Department of Natural Resources
4244 International Parkway, STE 114
Atlanta, GA 30354
Phone: (404) 362-2675
Fax: (404) 362-2653
Email: tom_hill@mail.dnr.state.ga.us

Hawaii: Noise and Radiation Branch,
Environmental Protection and Health Services Division
Department of Health
591 Ala Moana Blvd.
Honolulu, HI 96813
Phone: (808) 548-4383

Idaho: Grant Klokeid, Senior Radiation Physicist
X-Ray and Electronic Products
Laboratory Improvement Section
Division of Health
2220 Old Penitentiary RD.
Boise, ID 83712
Phone: (208) 334-2235
Fax: (208) 334-2382
Email: klokeidg(dhwtowers/towers3/klokeidg)@dhw.state.id.us

Illinois: Paul Eastvold, Manager
Office of Radiation Safety
Department of Nuclear Safety
1035 Outer Park Drive
Springfield, IL 62704
Phone: (217) 785-9918
Fax: (217) 782-1328
Email: eastvold@idns.state.il.us

Indiana: John H. Ruyack, Director
Indoor and Radiologic Health Division
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Indiana Department of Health
2 North Meridian Street, 5F
Indianapolis, IN 46204-3003
Phone: (317) 233-7146
Fax: (317) 233-7154
Email: jruyack@isdh.state.in.us

Iowa: Donald A. Flater, Chief
Bureau of Radiological Health
Iowa Department of Public Health
Lucas State Office Building
Des Moines, IA 50319
Phone: (515) 281-3478
Fax: (515) 242-6284
Email: dflater@idph.state.ia.us

Kansas: Vick L. Cooper, Chief
X-Ray & RAM Control Section
Dept. of Hlth. & Environment
Bureau of Air and Radiation
Forbes Field, Bldg. 283
Topeka, KS 66620-0001
Phone: (785) 296-1560
Fax: (785) 296-0984
Email: vcooper@kdhe.state.ks.us

Kentucky: John A. Volpe, Ph.D., Manager
Radiation Health and Toxic Agents Branch
Cabinet for Human Resources
Mail Stop HS 2E-D
275 East Main Street
Frankfort, KY 40621-0001
Phone: (502) 564-3700
Fax: (502) 564-6533
Email: jvolpe1@mail.state.ky.us

Louisiana: William H. Spell, Administrator
Radiation Protection Division
Office of Air Quality & Radiation Protection
P. O. Box 82135
Baton Rouge, LA 70884-2135
Phone: (504) 765-0160
Fax: (504) 765-0220
Email: bills@deq.state.la.us

Maryland: Roland G. Fletcher, Administrator
Radiological Health Program
Air & Radiation Mgmt. Admin.
Department of the Environment
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2500 Broening Highway
Baltimore, MD 21224
Phone: (410) 631-3300
Fax: (410) 631-3198
Email: rf0033@mail.state.md.us

Maine: Acting Manager
Radiation Control Program
Division of Health Engineering
10 State House Station
Augusta, ME 04333
Phone: (207) 287-5698
Fax: (207) 287-4172

Massachusetts: Robert M. Hallisey, Director
Radiation Control Program
Department of Public Health
305 South Street, 7th Floor
Jamaica Plain, MA 02130
Phone: (617) 727-6214
Fax: (617) 767-2098
Email: hallisey@world.std.com

Michigan: David W. Minnaar, Chief,
Radiological Protection Section
MI DEQ, Drinking Water and Radiological Protection Division
Radiological Protection Section
3423 N. Martin Luther King, Jr. Boulevard
P.O. Box 30630
Lansing, MI 48909-8130
Phone: (517) 335-8197
Fax: (517) 335-8706
Email: minnaard@state.mi.us

Minnesota: Judith Ball, Manager
Section of Asbestos, Indoor Air, Lead and Radiation
Division of Environmental Health
PO Box 64975
Minneapolis, MN 55164-0975
Phone: (612) 215-0945
Fax: (612) 215-0976
Email: ballj@mdh-envh.health.state.mn.us

Mississippi: Robert W. Goff, Director
Division of Radiological Health
Department of Health
P. O. Box 1700
Jackson, MS 39215-1700
Phone: (601) 354-6657
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Fax: (601) 354-6167
Email: rgoff@msdh.state.ms.us

Missouri: Gary McNutt, Rad. Hlth. Analyst III
Environmental Public Health
Department of Health
P. O. Box 570
Jefferson City, MO 65102-0570
Phone: (573) 751-6160
Fax: (573) 526-6946
Email: gmcnutt@mail.state.mo.us

Montana: George Eicholtz, Coordinator, Radiological Health Program
MT Dept of Public Health and Human Services
Cogswell Building
Licensure Bureau
P.O. Box 202951
Helena, MT 59620-2951
Phone: (406) 444-5266
Fax: (406) 444-1742

Nebraska: Division of Radiological Health
Department of Health
Centennial Mall, South,
Box 95007
Lincoln, NE 68509
Phone: (402) 471-2168

Nevada: Stanley R. Marshall, Supervisor
Radiological Health Section
Bureau of Health Protection Services
Nevada State Health Division
1179 Fairview Drive, STE 102
Carson City, NV 89701-5405
Phone: (702) 687-5394
Fax: (702) 687-5751
Email: smarshal@gov.mail.state.nv.us

New Hampshire: Diane E. Tefft, Administrator
Radiological Health Bureau
Division of Public Health Services
6 Hazen Drive Concord, NH 03301-6527
Phone: (603) 271-4588
Fax: (603) 225-2325
Email: dtefft@dhhs.state.nh.us

New Jersey: Jill Lipoti, Ph.D., Asst. Director
Radiation Protection Programs
Division of Environmental Safety Health & Analytical Programs DEP
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P.O. Box 415
Trenton, NJ 08625-0415
Phone: (609) 984-5636
Fax: (609) 633-2210
Email: jlipoti@dep.state.nj.us

New Mexico: William M. Floyd, Program Manager
NM Environment Department
Hazardous and Radioactive Materials Division
P.O. Box 26110
Santa Fe, NM 87502-6110
Phone: (505) 827-1564
Fax: (505) 827-1544
Email: william_floyd@nmenv.state.nm.us

New York: Karim Rimawi, Ph.D., Director
Bur. of Environ. Rad. Protect.
NYS Health Department
Two University Place
Albany, NY 12203
Phone: (518) 458-6461
Fax: (518) 458-6434
Email: kxr01@health.state.ny.us

North Carolina: Richard M. Fry, Director
Division of Radiation Protection
Dept. of Environment and Natural Resources
3825 Barrett Drive
Raleigh, NC 27609-7221
Phone: (919) 571-4141
Fax: (919) 571-4148
Email: mel_fry@mail.ehnr.state.nc.us

North Dakota: Dana K. Mount, Director
Div. of Environmental Engineering
ND Department of Health
P. O. Box 5520
Bismarck, ND 58506-5520
Phone: (701) 328-5188
Fax: (701) 328-5200 Email: ccmail.dmount@ranch.state.nd.us

Ohio: Roger L. Suppes, Chief
Bureau of Radiation Protection
Ohio Department of Health
P.O. Box 118
Columbus, OH 43266-0118
Phone: (614) 644-7860
Fax: (614) 644-0381
Email: rsuppes@gw.odh.state.oh.us

mailto:kxr01@health.state.ny.us
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Oklahoma: Mike Broderick, Env. Program Administrator
Radiation Management Section
Department of Environmental Quality
1000 N.E. 10th Street
Oklahoma City, OK 73117-1212
Phone: (405) 271-7484
Fax: (405) 271-8245
Email: mikebinok@aol.com

Oregon: Ray D. Paris, Manager
Oregon Health Division
Radiation Protection Services
800 NE Oregon Street
Portland, OR 97232
Phone: (503) 731-4014
Fax: (503) 731-4081
Email: ray.d.paris@state.or.us

Pennsylvania: Keith Kerns, Acting Director
Bureau of Radiation Protection
Dept. of Environmental Protection
Rachel Carson State Office Building
P. O. Box 8469
Harrisburg, PA 17105-8469
Phone: (717) 787-2480
Fax: (717) 783-8965
Email: kerns.keith@a1.dep.state.pa.us

Rhode Island: Marie Stoeckel, MPH, CIH, Chief
Office of Occup. & Rad. Health
Department of Health
3 Capitol Hill, Room 206
Providence, RI 02908-5097
Phone: (401) 222-2438
Fax: (401) 222-2456

South Carolina: Max K. Batavia, P.E., Chief
Bureau of Radiological Health
DHEC 2600 Bull Street
Columbia, SC 29201
Phone: (803) 737-7400
Fax: (803) 737-7412
Email: batavimk@columb54.dhec.state.sc.us

South Dakota: John Robertson, Medical Facilities Engineer
Office of Health Care Facilities
Licensure and Certification
615 East 4th Street
c/o 500 Capitol
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Pierre, SD 57501-5070
Phone: (605) 773-3356
Fax: (605) 773-6667

Tennessee: Michael H. Mobley, Director
Division of Radiological Health
L and C Annex, Third Floor
401 Church Street
Nashville, TN 37243-1532
Phone: (615) 532-0360
Fax: (615) 532-7938
Email: mmobley@mail.state.tn.us

Texas: Richard A. Ratliff, Chief
Bureau of Radiation Control
Department of Health
1100 West 49th Street
Austin, TX 78756-3189
Phone: (512) 834-6679
Fax: (512) 834-6708
Email: rratliff@brc1.tdh.texas.gov

Utah: William J. Sinclair, Director
Division of Radiation Control
Dept. of Environmental Quality
P. O. Box 144850
Salt Lake City, UT 84114-4850
Phone: (801) 536-4250
Fax: (801) 533-4097
Email: eqrad.bsinclai@email.state.ut.us

Vermont: Paul E. Clemons, Operations Chief
Occupational & Radiological Health
Department of Health
P. O. Box 70
Burlington, VT 05402
Phone: (802) 865-7730
Fax: (802) 865-7745

Virginia: Leslie P. Foldesi, Director
Bureau of Radiological Health
Department of Health
Main Street Station
1500 E. Main, Rm. 240
Richmond, VA 23219
Phone: (804) 786-5932
Fax: (804) 786-6979
Email: lfoldesi@vdh.state.va.us
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Washington: John L. Erickson, Director
Division of Radiation Protection
Washington Department of Health
Airdustrial Center Bldg. #5
P.O. Box 47827
Olympia, WA 98504-7827
Phone: (360) 236-3210
Fax: (360) 236-2255
Email: jle0303@hub.doh.wa.gov

West Virginia: Beattie L. DeBord, Chief
Radiological Health Program
815 Quarrier Street
Charleston, WV 25301
Phone: (304) 558-3526
Fax: (304) 558-0524

Wisconsin: Paul S. Schmidt, Manager
Radiation Protection Unit
Bureau of Public Health
Dept. of Health & Family Services
P. O. Box 309
Madison, WI 53701-0309
Phone: (608) 267-4792
Fax: (608) 267-4799
Email: schmips@dhfs.state.wi.us

Wyoming: Radiological Health Services
Division of Health and Medical Services
Hathaway Building
Cheyenne, WY 82002
Phone: (307) 777-6015

Appendix D - ARS Components

D1. Standard Components
see Figure D1 for ARS Standard Components Diagram.



Table A1.1
ARS SPARE PARTS MAINTENANCE



Table A1.1
ARS SPARE PARTS MAINTENANCE - CONT



Table B2.1
TROUBLESHOOTING ACTIONS



Table B3.1
POTENTIAL ERROR MESSAGES



Table B3.1



Table B3.1
POTENTIAL ERROR MESSAGES - CONT



Table B4.1
VARIABLE TEXT MESSAGES



Table C8.1



Table C8.2
METRIC REQUIREMENTS FOR CONTROL OF MAIN BEAM TO PRODUCT A DOSE OF LESS THAN  100 MR



Table 1.1
ARS VOLUME AND WEIGHT



Table 1.2
ARS STANDARD SYSTEM COMPONENTS



Table 1.3



Table 1.4



Table 1.4



Table 2.1
STANDARD ARS SYSTEM COMPONENTS



Table 2.2
BATTERY CHARGE INDICATOR LIGHT



Table 3.1



Table 3.2



Table 3.3



Table 5



Table 6



Figure C.1
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Figure D.1
ARS STANDARD COMPONENTS DIAGRAM
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Figure 1.1



Figure 2.1
FULLY ASSEMBLED ARS SHOWING THE SYSTEM COMPONENTS AND CABLE INTERCONNECTIONS



Figure 2.2
CONTROL UNIT DISPLAY PANEL



Figure 2.3



Figure 2.4
KEY PAD OPEN REVEALING BATTERY COMPARTMENT



Figure 2.5
ARS IMAGER AND X-RAY GENERATOR IN POSITION TO IMAGE OBJECTS ON THE GROUND



Figure 2.6
ARS IMAGER AND X-RAY GENERATOR IN POSITION TO IMAGE OBJECTS ON THE GROUND



Figure 2.7
ARS USER INTERFACE MAIN MENU SCREEN SHOWING MENU BAR ON THE TOP, ICONS BAR  BELOW, AND 



Figure 2.8
ARS WITH THE AQUIRE MENU ACTIVATED



Figure 2.9
ARS MAIN MENU WITH DIALOG BOX ACTIVATED BY ACQUIRE REQUEST



Figure 3.1
ARS WITH THE ACQUIRE DIALOG BOX ACTIVATED



Figure 3.2
ARS WITH THE DELAY COUNT DIALOG BOX ACTIVATED



Figure 3.3
ARS MAIN MENU WITH DIALOG BOX ACTIVATED BY THE OPEN REQUEST



Figure 3.4
ARS QUICK SAVE SELECTION FOR DIALOG BOX REQUEST



Figure 3.5
ARS MAIN MENU WITH DIALOG BOX ACTIVATED BY THE SAVE AS REQUEST



Figure 3.6



Figure 3.7
ARS PRINT SETUP DIALOG BOX



Figure 3.8
ARS MAIN MENU SHOWING THE DISPLAY MENU



Figure 3.9
ARS MAIN MENU SHOWING THE PALETTES SUBMENU



Figure 3.10
THE INVERTED GRAYSCALE FUNCTION ACTIVATED



Figure 3.11



Figure 3.12
ARS MAIN MENU WITH THE DISPLAY MENU THE GRID FUNCTION ACTIVE



Figure 3.13
THE DISTANCE FUNCTION MESSGE BOX DISPLAYED FOLLOWING FUNCTION ACTIVATION AND  INTERACTIVE



Figure 3.14
THE IMAGE HEADER DIALOG BOX



Figure 3.15
THE PULSE COUNT DIALOG BOX



Figure 3.16



Figure 3.17



Figure 3.18
THE ANNOTATE FUNCTION AND WHITE TEXT SUBMENU SHOWING WITH WHITE TEXT  APPEARING ON THE 



Figure 3.19
THE ANNOTATE FUNCTION AND WHITE LINE SUBMENU SHOWING



Figure 3.20
AN IMAGE WITH THE EXTREME SHARPEN TOOL APPLIED



Figure 3.21
AN IMAGE WITH THE EXTREME SMOOTH TOOL APPLIED



Figure 3.22
AN IMAGE WITH DESPECKLE NOISE REDUCTION APPLIED



Figure 3.23
HORIZONTAL EDGE DETECTION APPLIED TO THE IMAGE



Figure 3.24
THE EMBOSS FUNCTION APPLIED TO THE IMAGE



Figure 3.25



Figure 3.26
THE DISPLAY MENU AND ROTATE IMAGE SUBMENU PULLED DOWN, WITH THE  180 DEGREES FUNCTION 



Figure 3.27
MAIN MENU WITH THE PREFERENCES PULL-DOWN MENU ACTIVATED



Figure 3.28
ARS MAIN MENU WITH THE HELP PULL-DOWN MENU ACTIVATED



Figure 3.29
ARS MAIN MENU WITH THE HELP PULL-DOWN MENU KEY MAP OPTION ACTIVATED



Figure 3.30



Figure 4.1
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